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	TH2
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	PCON
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INTRODUCTION

EMBEDDED SYSTEMS

                Embedded systems are designed to do some specific task, rather than be a general-purpose computer for multiple tasks. Some also have real time performance constraints that must be met, for reason such as safety and usability; others may have low or no performance requirements, allowing the system hardware to be simplified to reduce costs.

                   An embedded system is not always a separate block - very often it is physically built-in to the device it is controlling.

The software written for embedded systems is often called firmware, and is stored in read-only memory or flash convector chips rather than a disk drive. It often runs with limited computer hardware resources: small or no keyboard, screen, and little memory.

In the present project we are demonstrating the applications of the CAN protocol in the Car Automation. Here we are showing the Antilock Breaking System (ABS) and the Automatic Climate Control System. 

The ABS brake system is the greatest innovation in active safety for cars that has saved many lives. The Anti-lock Braking System is designed to help the driver maintain steering control during hard braking, especially in slippery conditions. How it works: Imagine, you are driving a car without ABS on a slippery road (e.g. after a rain or snow). Suddenly, you notice something on the road right in front of you. You hit the brakes, and try to turn aside, but the steering doesn't work; the car just skids out of control. Why, because all the wheels are locked up while you are holding down the brake pedal. As a result, you lose the ability to steer the vehicle. The four-wheel ABS can help in situations like this. It prevents the wheels from locking up, helping you maintain steering control during braking. In a similar situation, driving a car equipped with four-wheel ABS, it would be easier for you to steer your vehicle while braking. Major components of the typical ABS system include speed sensors (one at each wheel), an electronic control unit (ABS computer) and a hydraulic control. The ABS computer constantly monitors the signal from each wheel speed sensor. When it senses that any of the wheels are approaching lock up during braking, the ABS computer sends the signal to the hydraulic control unit, which modulates the braking pressure for a corresponding wheel(s) preventing it from locking up. 

Today's automatic climate control systems allow hands-free temperature regulator, whether hot or cold. Once you set a temperature on your car’s automatic climate control system, it should maintain that temperature regardless of what's going on outside.
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BLOCK DIAGRAM EXPLANATION





The brief description of the block diagram of our project is discussed in this section.


Micro controller:

 In this project work the micro-controller is plays major role. Micro-controllers were originally used as components in complicated process-control systems.   However, because of their small size and low price, Micro-controllers are now also being used in regulators for individual control loops. In several areas Micro-controllers are now outperforming their analog counterparts and are cheaper as well.
POWER SUPPLY:

         A variable regulated power supply, also called a variable bench power supply, is one where you can continuously adjust the output voltage to your requirements. Varying the output of the power supply is the recommended way to test a project after having double checked parts placement against circuit drawings and the parts placement guide. This type of regulation is ideal for having a simple variable bench power supply. Actually this is quite important because one of the first projects a hobbyist should undertake is the construction of a variable regulated power supply. While a dedicated supply is quite handy e.g. 5V or 12V, it's much handier to have a variable supply on hand, especially for testing. Most digital logic circuits and processors need a 5 volt power supply. To use these parts we need to build a regulated 5 volt source. Usually you start with an unregulated power supply ranging from 9 volts to 24 volts DC (A 12 volt power supply is included with the Beginner Kit and the Microcontroller Beginner Kit.). To make a 5 volt power supply, we use a LM7805 voltage regulator IC.

The LM7805 is simple to use. You simply connect the positive lead of your unregulated DC power supply (anything from 9VDC to 24VDC) to the Input pin, connect the negative lead to the Common pin and then when you turn on the power, you get a 5 volt supply from the Output pin.
Motor driver: H-bridge 

                        H-bridge is to construct with transistors and Motor. It is used to rotate the Robot.
SENSORS:

This part of the system consists of temperature sensor. These sensors sense various parameters- of  temperature and then sent to the Analog to Digital Converter.
ADC:

This device will convert the analog values into digital format and fetches to the microcontroller. Here in this project we used single channel ADC .    

LCD:

LCD is used to display the information about the current process.
SCHEMATIC:
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SCHEMATIC DESCRIPTION:

Firstly, the required operating voltage for Microcontroller PIC16F877A is 5V. Hence the 5V D.C. power supply is needed by the same. This regulated 5V is generated by first stepping down the 230V to 18V by the step down transformer.


The operating voltage required by the relay circuit to switch devices is 12V with an increase in current driving capability. Hence another supply is required to generate 12V.

In the both the Power supplies the step downed a.c. voltage is being rectified by the Bridge Rectifier. The diodes used are 1N4007. The rectified a.c voltage is now filtered using a ‘C’ filter. Now the rectified, filtered D.C. voltage is fed to the Voltage Regulator. This voltage regulator allows us to have a Regulated Voltage. In Power supply given to Microcontroller 5V is generated using 7805 and in other two power supply 12V is generated using 7812. The rectified; filtered and regulated voltage is again filtered for ripples using an electrolytic capacitor 100μF. Now the output from the first section is fed to 32nd pin of 16F877A microcontroller to supply operating voltage and from other power supply to circuitry.

The microcontroller 16F877A with crystal oscillator of 8 MHz crystal in conjunction with couple of capacitors of  is placed at 13th & 14th pins of 16F877A to make it work (execute) properly.


The LCD is interfaced to Microcontroller. The data pins of LCD are connected to Port B. The control pins of LCD are connected to Port B as shown in schematic. 

The  MCP2515 consist of total 18 pins with crystal oscillator of 8 MHz crystal in conjunction with couple of capacitors of  is placed at 7th & 14th pins , 9th pin  is grounded, 18th pin is VCC , 13th , 14th , 15th & 16th  pins are connected to controller  18th , 24th , 23rd & 20th pins respectively. 1st & 2nd pins of MCP2515 are TX & RX pins which are connected to 1st & 4th  pin of MCP2551. 

A switch is connected to the RD0 and a DC Motor is connected to RC2 of Microcontroller respectively.

A Relay for bulb is connected to RC0 , a LDR with TTL logic is connected to RA1,  a temperature sensor (LM35) is connected to RA0 & a motor is connected to PC1 of controller.

Hardware Components:

1. Micro controller

2. Power supply

3. temperature sensor
4. can transmitter
5. can controller
6. dc motor
7. ADC
8. LCD

9. motor driver

PIC micro controller:

PIC16F87XA
High-Performance RISC CPU:
• Only 35 single-word instructions to learn

• All single-cycle instructions except for program branches, which are two-cycle

• Operating speed: DC – 20 MHz clock input DC – 200 ns instruction cycle

• Up to 8K x 14 words of Flash Program Memory, Up to 368 x 8 bytes of Data Memory (RAM),Up to 256 x 8 bytes of EEPROM Data Memory

• Pin out compatible to other 28-pin or 40/44-pin  PIC16CXXX and PIC16FXXX microcontrollers
Peripheral Features:
• Timer0: 8-bit timer/counter with 8-bit pre scaler

• Timer1: 16-bit timer/counter with pre scaler, can be incremented during Sleep via external crystal/clock

• Timer2: 8-bit timer/counter with 8-bit period register, pre scaler and post scaler

• Two Capture, Compare, PWM modules

- Capture is 16-bit, max. resolution is 12.5 ns

- Compare is 16-bit, max. resolution is 200 ns

- PWM max. resolution is 10-bit

• Synchronous Serial Port (SSP) with SPI™(Master mode) and I2C™ (Master/Slave)

• Universal Synchronous Asynchronous Receiver Transmitter (USART/SCI) with 9-bit address detection

• Parallel Slave Port (PSP) – 8 bits wide with external RD, WR and CS controls (40/44-pin only)

• Brown-out detection circuitry for Brown-out Reset (BOR)
Analog Features:
• 10-bit, up to 8-channel Analog-to-Digital Converter (A/D)

• Brown-out Reset (BOR)

• Analog Comparator module with:

- Two analog comparators

- Programmable on-chip voltage reference(VREF) module

- Programmable input multiplexing from device inputs and internal voltage reference

- Comparator outputs are externally accessible

Special Microcontroller Features:
• 100,000 erase/write cycle Enhanced Flash program memory typical

• 1,000,000 erase/write cycle Data EEPROM memory typical

• Data EEPROM Retention > 40 years

• Self-reprogrammable under software control

• In-Circuit Serial Programming™ (ICSP™)via two pins

• Single-supply 5V In-Circuit Serial Programming

• Watchdog Timer (WDT) with its own on-chip RC oscillator for reliable operation

• Programmable code protection

• Power saving Sleep mode

• Selectable oscillator options

• In-Circuit Debug (ICD) via two pins
CMOS Technology:
• Low-power, high-speed Flash/EEPROMtechnology

• Fully static design

• Wide operating voltage range (2.0V to 5.5V)

• Commercial and Industrial temperature ranges

• Low-power consumption

• PIC16F873A

• PIC16F874A

• PIC16F876A

[image: image4.emf]
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1.0 DEVICE OVERVIEW

This document contains device specific informationabout the following devices:

• PIC16F873A

• PIC16F874A

• PIC16F876A

• PIC16F877A


PIC16F873A/876A devices are available only in 28-pinpackages, while PIC16F874A/877A devices are available in 40-pin and 44-pin packages. All devices in the PIC16F87XA family share common architecture with the following differences:
• The PIC16F873A and PIC16F874A have one-half of the total on-chip memory of the PIC16F876A and PIC16F877A

• The 28-pin devices have three I/O ports, while the 40/44-pin devices have five

• The 28-pin devices have fourteen interrupts, while the 40/44-pin devices have fifteen

• The 28-pin devices have five A/D input channels, while the 40/44-pin devices have eight

• The Parallel Slave Port is implemented only on the 40/44-pin devices The available features are summarized in Table 1-1. Block diagrams of the PIC16F873A/876A and

PIC16F874A/877A devices are provided in Figure 1-1 and Figure 1-2, respectively. The pinouts for these device families are listed in Table 1-2 and Table 1-3.

Additional information may be found in the PICmicro® Mid-Range Reference Manual (DS33023), which may be obtained from your local Microchip Sales Representative

or downloaded from the Microchip web site. The Reference Manual should be considered a complementary document to this data sheet and is highly recommended reading for a better understanding of the device architecture and operation of the peripheral mo[image: image6.emf]
[image: image7.emf]
2.0 MEMORY ORGANIZATION
There are three memory blocks in each of the PIC16F87XA devices. The program memory and data memory have separate buses so that concurrent access can occur and is detailed in this section. The EEPROM data memory block is detailed in Section 3.0

“Data EEPROM and Flash Program Memory”. Additional information on device memory may be found in the PICmicro® Mid-Range MCU Family Reference

Manual (DS33023).

2.1 Program Memory Organization
The PIC16F87XA devices have a 13-bit program counter capable of addressing an 8K word x 14 bit program memory space. The PIC16F876A/877A devices have 8K words x 14 bits of Flash program memory, while PIC16F873A/874A devices have 4K words x 14 bits. Accessing a location above the physically implemented address will cause a

wraparound. The Reset vector is at 0000h and the interrupt vector is at 0004h.

[image: image8.emf]
2.2 Data Memory Organization
The data memory is partitioned into multiple banks which contain the General Purpose Registers and the Special Function Registers. Bits RP1 (Status<6>) and RP0 (Status<5>) are the bank select bits. Each bank extends up to 7Fh (128 bytes). The lower locations of each bank are reserved for the Special Function Registers. Above the Special Function Registers are General Purpose Registers, implemented as static RAM. All implemented banks contain Special Function Registers. Some frequently used Special  another bank for code reduction and quicker access.

[image: image9.emf]
GENERAL PURPOSE REGISTERFILE
The register file can be accessed either directly, or indirectly, through the File Select Register (FSR).Status Register The Status register contains the arithmetic status of the

ALU, the Reset status and the bank select bits for data memory. The Status register can be the destination for any instruction, as with any other register. If the Status register

is the destination for an instruction that affects the Z, DC or C bits, then the write to these three bits is disabled. These bits are set or cleared according to the device logic. Furthermore, the TO and PD bits are not writable, therefore, the result of an instruction with the Status register as destination may be different than intended. For example, CLRF STATUS, will clear the upper three bits and set the Z bit. This leaves the Status register as 000u u1uu (where u = unchanged). It is recommended, therefore, that only BCF, BSF,

SWAPF and MOVWF instructions are used to alter the Status register because these instructions do not affect the Z, C or DC bits from the Status register. For other

instructions not affecting any status bits, see

Section 15.0 “Instruction Set Summary”.

REGISTER 2-1: STATUS REGISTER (ADDRESS 03h, 83h, 103h, 183h)

Note: The C and DC bits operate as a borrow and digit borrow bit, respectively, in subtraction. See the SUBLW and SUBWF instructions for examples.

bit 7 IRP: Register Bank Select bit (used for indirect addressing)

1 = Bank 2, 3 (100h-1FFh)

0 = Bank 0, 1 (00h-FFh)

bit 6-5 RP1:RP0: Register Bank Select bits (used for direct addressing)

11 = Bank 3 (180h-1FFh)

10 = Bank 2 (100h-17Fh)

01 = Bank 1 (80h-FFh)

00 = Bank 0 (00h-7Fh)

Each bank is 128 bytes.

bit 4 TO: Time-out bit

1 = After power-up, CLRWDT instruction or SLEEP instruction

0 = A WDT time-out occurred
bit 3 PD: Power-down bit

1 = After power-up or by the CLRWDT instruction

0 = By execution of the SLEEP instruction

bit 2 Z: Zero bit
1 = The result of an arithmetic or logic operation is zero

0 = The result of an arithmetic or logic operation is not zero

bit 1 DC: Digit carry/borrow bit (ADDWF, ADDLW,SUBLW,SUBWF instructions)

(for borrow, the polarity is reversed)

1 = A carry-out from the 4th low order bit of the result occurred

0 = No carry-out from the 4th low order bit of the result

bit 0 C: Carry/borrow bit (ADDWF, ADDLW,SUBLW,SUBWF instructions)

1 = A carry-out from the Most Significant bit of the result occurred

0 = No carry-out from the Most Significant bit of the result occurred

Note: For borrow, the polarity is reversed. A subtraction is executed by adding the two’s

complement of the second operand. For rotate (RRF, RLF) instructions, this bit is loaded with either the high, or low order bit of the source register.

Legend:

R = Readable bit W = Writable bit U = Unimplemented bit, read as ‘0’

- n = Value at POR ‘1’ = Bit is set ‘0’ = Bit is cleared x = Bit is unknown

2003 Microchip Technology Inc. DS39582B-page 23

PIC16F87XA

2.2.2.2 OPTION_REG Register

The OPTION_REG Register is a readable and writable

register, which contains various control bits to configure

the TMR0 prescaler/WDT postscaler (single assignable

register known also as the prescaler), the external

INT interrupt, TMR0 and the weak pull-ups on PORTB.

REGISTER 2-2: OPTION_REG REGISTER (ADDRESS 81h, 181h)

Note: To achieve a 1:1 prescaler assignment for the TMR0 register, assign the prescaler to the Watchdog Timer.

bit 7 bit 0

bit 7 RBPU: PORTB Pull-up Enable bit

1 = PORTB pull-ups are disabled

0 = PORTB pull-ups are enabled by individual port latch values

bit 6 INTEDG: Interrupt Edge Select bit

1 = Interrupt on rising edge of RB0/INT pin

0 = Interrupt on falling edge of RB0/INT pin

bit 5 T0CS: TMR0 Clock Source Select bit

1 = Transition on RA4/T0CKI pin

0 = Internal instruction cycle clock (CLKO)

bit 4 T0SE: TMR0 Source Edge Select bit

1 = Increment on high-to-low transition on RA4/T0CKI pin

0 = Increment on low-to-high transition on RA4/T0CKI pin

bit 3 PSA: Prescaler Assignment bit

1 = Prescaler is assigned to the WDT

0 = Prescaler is assigned to the Timer0 module

bit 2-0 PS2:PS0: Prescaler Rate Select bits

Legend:

R = Readable bit W = Writable bit U = Unimplemented bit, read as ‘0’

- n = Value at POR ‘1’ = Bit is set ‘0’ = Bit is cleared x = Bit is unknown

Note: When using Low-Voltage ICSP Programming (LVP) and the pull-ups on PORTB are enabled, bit 3 in the TRISB register must be cleared to disable the pull-up on RB3

and ensure the proper operation of the device Bit Value TMR0 Rate WDT Rate

PIC16F87XA

DS39582B-page 24 2003 Microchip Technology Inc.2.2.2.3 INTCON Register

The INTCON register is a readable and writable register, which contains various enable and flag bits for the TMR0 register overflow, RB port change and external

RB0/INT pin interrupts.

REGISTER 2-3: INTCON REGISTER (ADDRESS 0Bh, 8Bh, 10Bh, 18Bh)

Note: Interrupt flag bits are set when an interrupt condition occurs regardless of the state of its corresponding enable bit or the global enable bit, GIE (INTCON<7>). User software should ensure the appropriate interrupt flag bits are clear prior to enabling an interrupt.

bit 7 bit 0

bit 7 GIE: Global Interrupt Enable bit

1 = Enables all unmasked interrupts

0 = Disables all interrupts

bit 6 PEIE: Peripheral Interrupt Enable bit

1 = Enables all unmasked peripheral interrupts

0 = Disables all peripheral interrupts

bit 5 TMR0IE: TMR0 Overflow Interrupt Enable bit

1 = Enables the TMR0 interrupt

0 = Disables the TMR0 interrupt

bit 4 INTE: RB0/INT External Interrupt Enable bit

1 = Enables the RB0/INT external interrupt

0 = Disables the RB0/INT external interrupt

bit 3 RBIE: RB Port Change Interrupt Enable bit

1 = Enables the RB port change interrupt

0 = Disables the RB port change interrupt

bit 2 TMR0IF: TMR0 Overflow Interrupt Flag bit

1 = TMR0 register has overflowed (must be cleared in software)

0 = TMR0 register did not overflow

bit 1 INTF: RB0/INT External Interrupt Flag bit

1 = The RB0/INT external interrupt occurred (must be cleared in software)

0 = The RB0/INT external interrupt did not occur

bit 0 RBIF: RB Port Change Interrupt Flag bit

1 = At least one of the RB7:RB4 pins changed state; a mismatch condition will continue to set

the bit. Reading PORTB will end the mismatch condition and allow the bit to be cleared

(must be cleared in software).

0 = None of the RB7:RB4 pins have changed state

PIC16F87XA

 PIE1 Register

The PIE1 register contains the individual enable bits for

the peripheral interrupts.
REGISTER 2-4: PIE1 REGISTER (ADDRESS 8Ch)

Note: Bit PEIE (INTCON<6>) must be set to enable any peripheral interrupt.

bit 7 bit 0

bit 7 PSPIE: Parallel Slave Port Read/Write Interrupt Enable bit(1)

1 = Enables the PSP read/write interrupt

0 = Disables the PSP read/write interrupt

Note 1: PSPIE is reserved on PIC16F873A/876A devices; always maintain this bit clear.

bit 6 ADIE: A/D Converter Interrupt Enable bit

1 = Enables the A/D converter interrupt

0 = Disables the A/D converter interrupt

bit 5 RCIE: USART Receive Interrupt Enable bit

1 = Enables the USART receive interrupt

0 = Disables the USART receive interrupt

bit 4 TXIE: USART Transmit Interrupt Enable bit

1 = Enables the USART transmit interrupt

0 = Disables the USART transmit interrupt

bit 3 SSPIE: Synchronous Serial Port Interrupt Enable bit

1 = Enables the SSP interrupt

0 = Disables the SSP interrupt

bit 2 CCP1IE: CCP1 Interrupt Enable bit

1 = Enables the CCP1 interrupt

0 = Disables the CCP1 interrupt

bit 1 TMR2IE: TMR2 to PR2 Match Interrupt Enable bit

1 = Enables the TMR2 to PR2 match interrupt

0 = Disables the TMR2 to PR2 match interrupt

bit 0 TMR1IE: TMR1 Overflow Interrupt Enable bit

1 = Enables the TMR1 overflow interrupt

0 = Disables the TMR1 overflow interrupt

Legend:

R = Readable bit W = Writable bit U = Unimplemented bit, read as ‘0’

- n = Value at POR ‘1’ = Bit is set ‘0’ = Bit is cleared x = Bit is unknown

 PIR1 Register:

The PIR1 register contains the individual flag bits for the peripheral interrupts.

REGISTER 2-5: PIR1 REGISTER (ADDRESS 0Ch)
Note: Interrupt flag bits are set when an interrupt condition occurs regardless of the state of its corresponding enable bit or the global enable bit, GIE (INTCON<7>). User software should ensure the appropriate interrupt bits are clear prior to enabling an interrupt.

bit 7 bit 0

bit 7 PSPIF: Parallel Slave Port Read/Write Interrupt Flag bit(1)

1 = A read or a write operation has taken place (must be cleared in software)

0 = No read or write has occurred

Note 1: PSPIF is reserved on PIC16F873A/876A devices; always maintain this bit clear.

bit 6 ADIF: A/D Converter Interrupt Flag bit

1 = An A/D conversion completed

0 = The A/D conversion is not complete

bit 5 RCIF: USART Receive Interrupt Flag bit

1 = The USART receive buffer is full

0 = The USART receive buffer is empty

bit 4 TXIF: USART Transmit Interrupt Flag bit

1 = The USART transmit buffer is empty

0 = The USART transmit buffer is full

bit 3 SSPIF: Synchronous Serial Port (SSP) Interrupt Flag bit

1 = The SSP interrupt condition has occurred and must be cleared in software before returning

from the Interrupt Service Routine. The conditions that will set this bit are:

• SPI – A transmission/reception has taken place.

• I2C Slave – A transmission/reception has taken place.

• I2C Master

- A transmission/reception has taken place.

- The initiated Start condition was completed by the SSP module.

- The initiated Stop condition was completed by the SSP module.

- The initiated Restart condition was completed by the SSP module.

- The initiated Acknowledge condition was completed by the SSP module.

- A Start condition occurred while the SSP module was Idle (multi-master system).

- A Stop condition occurred while the SSP module was Idle (multi-master system).
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 Status Register:

The Status register contains the arithmetic status of the ALU, the Reset status and the bank select bits for data memory. The Status register can be the destination for any

instruction, as with any other register. If the Status register is the destination for an instruction that affects the Z, DC or C bits, then the write to these three bits is disabled.

These bits are set or cleared according to the device logic. Furthermore, the TO and PD bits are not writable, therefore, the result of an instruction with the Status register as destination may be different than intended.

For example, CLRF STATUS, will clear the upper three bits and set the Z bit. This leaves the Status register as 000u u1uu (where u = unchanged). It is recommended, therefore, that only BCF, BSF, SWAPF and MOVWF instructions are used to alter the Status register because these instructions do not affect the Z, C or DC bits from the Status register. For other instructions not affecting any status bits, see

Section 15.0 “Instruction Set Summary”.

REGISTER 2-1: STATUS REGISTER (ADDRESS 03h, 83h, 103h, 183h)

Note: The C and DC bits operate as a borrow and digit borrow bit, respectively, in subtraction.

2 OPTION_REG Register

The OPTION_REG Register is a readable and writable register, which contains various control bits to configure the TMR0 prescaler/WDT postscaler (single assignable

register known also as the prescaler), the external INT interrupt, TMR0 and the weak pull-ups on PORTB.

REGISTER 2-2: OPTION_REG REGISTER (ADDRESS 81h, 181h)
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PIE1 Register

The PIE1 register contains the individual enable bits for

the peripheral interrupts.

REGISTER 2-4: PIE1 REGISTER (ADDRESS 8Ch)

[image: image17.emf]
PIR1 Register

The PIR1 register contains the individual flag bits for

the peripheral interrupts.

REGISTER 2-5: PIR1 REGISTER (ADDRESS 0Ch)
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PCON Register

The Power Control (PCON) register contains flag bits

to allow differentiation between a Power-on Reset

(POR), a Brown-out Reset (BOR), a Watchdog Reset

(WDT) and an external MCLR Reset.

REGISTER 2-8: PCON REGISTER (ADDRESS 8Eh)

[image: image19.emf]
PCL and PCLATH
The Program Counter (PC) is 13 bits wide. The low byte comes from the PCL register which is a readable and writable register. The upper bits (PC<12:8>) are not readable, but are indirectly writable through the PCLATH register. On any Reset, the upper bits of the

PC will be cleared. Figure 2-5 shows the two situations for the loading of the PC. The upper example in the figure shows how the PC is loaded on a write to PCL

(PCLATH<4:0> →PCH). The lower example in the figure shows how the PC is loaded during a CALL or GOTO instruction (PCLATH<4:3> →PCH).
 LOADING OF PC IN
DIFFERENT SITUATIONS


2.3.1 COMPUTED GOTO

A computed GOTO is accomplished by adding an offset to the program counter (ADDWF PCL). When doing a table read using a computed GOTO method, care

should be exercised if the table location crosses a PCL memory boundary (each 256-byte block). Refer to the application note, AN556, “Implementing a Table Read”
(DS00556).

2.3.2 STACK

The PIC16F87XA family has an 8-level deep x 13-bit wide hardware stack. The stack space is not part of either program or data space and the stack pointer is not readable or writable. The PC is PUSHed onto the stack when a CALL instruction is executed, or an interrupt causes a branch. The stack is POP’ed in the event of a RETURN, RETLW or a RETFIE instruction execution. PCLATH is not affected by a PUSH or POP operation.

The stack operates as a circular buffer. This means that after the stack has been PUSHed eight times, the ninth push overwrites the value that was stored from the first

push. The tenth push overwrites the second push (and so on).

2.4 Program Memory Paging

All PIC16F87XA devices are capable of addressing a continuous 8K word block of program memory. The CALL and GOTO instructions provide only 11 bits of
 address to allow branching within any 2K program memory page. When doing a CALL or GOTO instruction, the upper 2 bits of the address are provided by PCLATH<4:3>. When doing a CALL or GOTO instruction, the user must ensure that the page select bits are programmed so that the desired program memory page is addressed. If a return from a CALL instruction (or interrupt) is executed, the entire 13-bit PC is popped off the stack. Therefore, manipulation of the PCLATH<4:3> bits is not required for the RETURN instructions (which POPs the address from the stack). Example 2-1 shows the calling of a subroutine in page 1 of the program memory. This example assumes that PCLATH is saved and restored by the Interrupt Service Routine (if interrupts are used).

3.0 DATA EEPROM AND FLASH

PROGRAM MEMORY

The data EEPROM and Flash program memory is readable and writable during normal operation (over the full VDD range). This memory is not directly mapped in the register file space. Instead, it is indirectly addressed through the Special Function Registers. There are six

SFRs used to read and write this memory:

• EECON1

• EECON2

• EEDATA

• EEDATH

• EEADR

• EEADRH

When interfacing to the data memory block, EEDATA holds the 8-bit data for read/write and EEADR holds the address of the EEPROM location being accessed. These devices have 128 or 256 bytes of data EEPROM (depending on the device), with an address range from 00h to FFh. On devices with 128 bytes, addresses from 80h to FFh are unimplemented and will wraparound to the beginning of data EEPROM memory. When writing to unimplemented locations, the on-chip charge pump will be turned off. When interfacing the program memory block, the EEDATA and EEDATH registers form a two-byte word that holds the 14-bit data for read/write and the EEADR and EEADRH registers form a two-byte word that holds the 13-bit address of the program memory location being accessed. These devices have 4 or 8K words of program Flash, with an address range from 0000h to 0FFFh for the PIC16F873A/874A and 0000h to 1FFFh

for the PIC16F876A/877A. Addresses above the range of the respective device will wraparound to the beginning of program memory. The EEPROM data memory allows single-byte read and write. The Flash program memory allows single-word reads and four-word block writes. Program memory write operations automatically perform an erase-before write on blocks of four words. A byte write in data EEPROM memory automatically erases the location and writes the new data (erase-before-write).

The write time is controlled by an on-chip timer. The write/erase voltages are generated by an on-chip charge pump, rated to operate over the voltage range of the device for byte or word operations. When the device is code-protected, the CPU may continue to read and write the data EEPROM memory. Depending on the settings of the write-protect bits, the device may or may not be able to write certain blocks of the program memory however, reads of the program memory are allowed. When code-protected, the device

programmer can no longer access data or program memory; this does NOT inhibit internal reads or writes.
3.1 EEADR and EEADRH
The EEADRH:EEADR register pair can address up to a maximum of 256 bytes of data EEPROM or up to a maximum of 8K words of program EEPROM. When selecting a data address value, only the LSByte of the address is written to the EEADR register. When selecting a program address value, the MSByte of the address is written to the EEADRH register and the LSByte is written to the EEADR register. If the device contains less memory than the full address reach of the address register pair, the Most Significant

bits of the registers are not implemented. For example, if the device has 128 bytes of data EEPROM, the Most Significant bit of EEADR is not implemented on access

to data EEPROM
3.2 EECON1 and EECON2 Registers

EECON1 is the control register for memory accesses. Control bit, EEPGD, determines if the access will be a program or data memory access. When clear, as it is when reset, any subsequent operations will operate on the data memory. When set, any subsequent

operations will operate on the program memory. Control bits, RD and WR, initiate read and write or erase, respectively. These bits cannot be cleared, only set, in software. They are cleared in hardware at completion of the read or write operation. The inability to

clear the WR bit in software prevents the accidental, premature termination of a write operation. The WREN bit, when set, will allow a write or erase operation. On power-up, the WREN bit is clear. The WRERR bit is set when a write (or erase) operation is

interrupted by a MCLR or a WDT Time-out Reset during normal operation. In these situations, following Reset, the user can check the WRERR bit and rewrite

the location. The data and address will be unchangedin the EEDATA and EEADR registers. Interrupt flag bit, EEIF in the PIR2 register, is set when the write is complete. It must be cleared in software. EECON2 is not a physical register. Reading EECON2

will read all ‘0’s. The EECON2 register is used exclusively in the EEPROM write sequence.

Note: The self-programming mechanism for Flash program memory has been changed. On previous PIC16F87X devices, Flash programming was done in single-word erase/

write cycles. The newer PIC18F87XA devices use a four-word erase/write cycle. 

 I/O PORTS
Some pins for these I/O ports are multiplexed with an alternate function for the peripheral features on the device. In general, when a peripheral is enabled, that pin may not be used as a general purpose I/O pin. Additional information on I/O ports may be found in the

PICmicro™ Mid-Range Reference Manual (DS33023).
4.1 PORTA and the TRISA Register

PORTA is a 6-bit wide, bidirectional port. The corresponding data direction register is TRISA. Setting a TRISA bit (= 1) will make the corresponding PORTA pin an input (i.e., put the corresponding output driver in a High-Impedance mode). Clearing a TRISA bit (= 0) will make the corresponding PORTA pin an output (i.e., put the contents of the output latch on the selected pin). Reading the PORTA register reads the status of the pins, whereas writing to it will write to the port latch. All write operations are read-modify-write operations. Therefore, a write to a port implies that the port pins are read, the value is modified and then written to the port data latch. Pin RA4 is multiplexed with the Timer0 module clock input to become the RA4/T0CKI pin. The RA4/T0CKI

pin is a Schmitt Trigger input and an open-drain output. All other PORTA pins have TTL input levels and full. CMOS output drivers. Other PORTA pins are multiplexed with analog inputs and the analog VREF input for both the A/D converters and the comparators. The operation of each pin is selected by clearing/setting the appropriate control bits in the ADCON1 and/or CMCON registers. The TRISA register controls the direction of the port pins even when they are being used as analog inputs. The user must ensure the bits in the TRISA register are maintained set when using them as analog inputs.
PORTB and the TRISB Register

PORTB is an 8-bit wide, bidirectional port. The corresponding

data direction register is TRISB. Setting a

TRISB bit (= 1) will make the corresponding PORTB

pin an input (i.e., put the corresponding output driver in

a High-Impedance mode). Clearing a TRISB bit (= 0)

will make the corresponding PORTB pin an output (i.e.,

put the contents of the output latch on the selected pin).

Three pins of PORTB are multiplexed with the In-Circuit

Debugger and Low-Voltage Programming function:

RB3/PGM, RB6/PGC and RB7/PGD. The alternate

functions of these pins are described in Section 14.0

“Special Features of the CPU”.

Each of the PORTB pins has a weak internal pull-up. A

single control bit can turn on all the pull-ups. This is performed

by clearing bit RBPU (OPTION_REG<7>). The

weak pull-up is automatically turned off when the port

pin is configured as an output. The pull-ups are

disabled on a Power-on Reset.

FIGURE 4-4: BLOCK DIAGRAM OF

RB3:RB0 PINS

Four of the PORTB pins, RB7:RB4, have an interrupton-

change feature. Only pins configured as inputs can

cause this interrupt to occur (i.e., any RB7:RB4 pin

configured as an output is excluded from the interrupton-

change comparison). The input pins (of RB7:RB4)

are compared with the old value latched on the last

read of PORTB. The “mismatch” outputs of RB7:RB4

are OR’ed together to generate the RB port change

interrupt with flag bit RBIF (INTCON<0>).

This interrupt can wake the device from Sleep. The

user, in the Interrupt Service Routine, can clear the

interrupt in the following manner:

a) Any read or write of PORTB. This will end the

mismatch condition.

b) Clear flag bit RBIF.

A mismatch condition will continue to set flag bit RBIF.

Reading PORTB will end the mismatch condition and

allow flag bit RBIF to be cleared.

The interrupt-on-change feature is recommended for

wake-up on key depression operation and operations

where PORTB is only used for the interrupt-on-change

feature. Polling of PORTB is not recommended while

using the interrupt-on-change feature.

This interrupt-on-mismatch feature, together with software

configurable pull-ups on these four pins, allow

easy interface to a keypad and make it possible for

wake-up on key depression. Refer to the application

note, AN552, “Implementing Wake-up on Key Stroke”

(DS00552).

RB0/INT is an external interrupt input pin and is

configured using the INTEDG bit (OPTION_REG<6>).

RB0/INT is discussed in detail in Section 14.11.1 “INT

Interrupt”.

PORTC and the TRISC Register

PORTC is an 8-bit wide, bidirectional port. The corresponding

data direction register is TRISC. Setting a

TRISC bit (= 1) will make the corresponding PORTC

pin an input (i.e., put the corresponding output driver in

a High-Impedance mode). Clearing a TRISC bit (= 0)

will make the corresponding PORTC pin an output (i.e.,

put the contents of the output latch on the selected pin).

PORTC is multiplexed with several peripheral functions

(Table 4-5). PORTC pins have Schmitt Trigger input

buffers.

When the I2C module is enabled, the PORTC<4:3>

pins can be configured with normal I2C levels, or with

SMBus levels, by using the CKE bit (SSPSTAT<6>).

When enabling peripheral functions, care should be

taken in defining TRIS bits for each PORTC pin. Some

peripherals override the TRIS bit to make a pin an

output, while other peripherals override the TRIS bit to

make a pin an input. Since the TRIS bit override is in

effect while the peripheral is enabled, read-modifywrite

instructions (BSF, BCF, XORWF) with TRISC as the

destination, should be avoided. The user should refer

to the corresponding peripheral section for the correct

TRIS bit settings

PORTD and TRISD Registers

PORTD is an 8-bit port with Schmitt Trigger input

buffers. Each pin is individually configurable as an input

or output.

PORTD can be configured as an 8-bit wide

microprocessor port (Parallel Slave Port) by setting

control bit, PSPMODE (TRISE<4>). In this mode, the

input buffers are TTL.

PORTE and TRISE Register

PORTE has three pins (RE0/RD/AN5, RE1/WR/AN6

and RE2/CS/AN7) which are individually configurable

as inputs or outputs. These pins have Schmitt Trigger

input buffers.

The PORTE pins become the I/O control inputs for the

microprocessor port when bit PSPMODE (TRISE<4>) is

set. In this mode, the user must make certain that the

TRISE<2:0> bits are set and that the pins are configured

as digital inputs. Also, ensure that ADCON1 is configured

for digital I/O. In this mode, the input buffers are

TTL.

Register 4-1 shows the TRISE register which also

controls the Parallel Slave Port operation.

PORTE pins are multiplexed with analog inputs. When

selected for analog input, these pins will read as ‘0’s.

TRISE controls the direction of the RE pins, even when

they are being used as analog inputs. The user must

make sure to keep the pins configured as inputs when

using them as analog inputs.

Parallel Slave Port

The Parallel Slave Port (PSP) is not implemented on

the PIC16F873A or PIC16F876A.

PORTD operates as an 8-bit wide Parallel Slave Port,

or microprocessor port, when control bit PSPMODE

(TRISE<4>) is set. In Slave mode, it is asynchronously

readable and writable by the external world through RD

control input pin, RE0/RD/AN5, and WR control input

pin, RE1/WR/AN6.

The PSP can directly interface to an 8-bit

microprocessor data bus. The external microprocessor

can read or write the PORTD latch as an 8-bit latch.

Setting bit PSPMODE enables port pin RE0/RD/AN5 to

be the RD input, RE1/WR/AN6 to be the WR input and

RE2/CS/AN7 to be the CS (Chip Select) input. For this

functionality, the corresponding data direction bits of

the TRISE register (TRISE<2:0>) must be configured

as inputs (set). The A/D port configuration bits,

PCFG3:PCFG0 (ADCON1<3:0>), must be set to

configure pins RE2:RE0 as digital I/O.

There are actually two 8-bit latches: one for data output

and one for data input. The user writes 8-bit data to the

PORTD data latch and reads data from the port pin

latch (note that they have the same address). In this

mode, the TRISD register is ignored since the external

device is controlling the direction of data flow.

A write to the PSP occurs when both the CS and WR

lines are first detected low. When either the CS or WR

lines become high (level triggered), the Input Buffer Full

(IBF) status flag bit (TRISE<7>) is set on the Q4 clock

cycle, following the next Q2 cycle, to signal the write is

complete (Figure 4-11). The interrupt flag bit, PSPIF

(PIR1<7>), is also set on the same Q4 clock cycle. IBF

can only be cleared by reading the PORTD input latch.

The Input Buffer Overflow (IBOV) status flag bit

(TRISE<5>) is set if a second write to the PSP is

attempted when the previous byte has not been read

out of the buffer.

A read from the PSP occurs when both the CS and RD

lines are first detected low. The Output Buffer Full

(OBF) status flag bit (TRISE<6>) is cleared

immediately (Figure 4-12), indicating that the PORTD

latch is waiting to be read by the external bus. When


either the CS or RD pin becomes high (level triggered),

the interrupt flag bit PSPIF is set on the Q4 clock cycle,

following the next Q2 cycle, indicating that the read is

complete. OBF remains low until data is written to

PORTD by the user firmware.

When not in PSP mode, the IBF and OBF bits are held

clear. However, if flag bit IBOV was previously set, it

must be cleared in firmware.

An interrupt is generated and latched into flag bit

PSPIF when a read or write operation is completed.

PSPIF must be cleared by the user in firmware and the

interrupt can be disabled by clearing the interrupt

enable bit PSPIE (PIE1<7>).
Power supply

                                             The power supplies are designed to convert high voltage AC mains electricity to a suitable low voltage supply for electronics circuits and other devices. A power supply can by broken down into a series of blocks, each of which performs a particular function. A d.c power supply which maintains the output voltage constant irrespective of a.c mains fluctuations or load variations is known as “Regulated D.C Power Supply”

For example a 5V regulated power supply system as shown below: 
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Components of a typical linear power supply





Transformer:

A transformer is an electrical device which is used to convert electrical power from one 

electrical circuit to another without change in frequency.

Transformers convert AC electricity from one voltage to another with little loss of power. Transformers work only with AC and this is one of the reasons why mains electricity is AC.  Step-up transformers increase in output voltage, step-down transformers decrease in output voltage. Most power supplies use a step-down transformer to reduce the dangerously high mains voltage to a safer low voltage.   The input coil is called the primary and the output coil is called the secondary. There is no electrical connection between the two coils; instead they are linked by an alternating magnetic field created in the soft-iron core of the transformer. The two lines in the middle of the circuit symbol represent the core.   Transformers waste very little power so the power out is (almost) equal to the power in. Note that as voltage is stepped down current is stepped up.   The ratio of the number of turns on each coil, called the turn’s ratio, determines the ratio of the voltages. A step-down transformer has a large number of turns on its primary (input) coil which is connected to the high voltage mains supply, and a small number of turns on its secondary (output) coil to give a low output voltage. 
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 An Electrical Transformer

Turns ratio = Vp/ VS = Np/NS

Power Out= Power In
VS X IS=VP X IP
Vp = primary (input) voltage
Np = number of turns on primary coil
Ip  = primary (input) current     

RECTIFIER:

             A circuit which is used to convert a.c to dc is known as RECTIFIER. The process of conversion a.c to d.c is called “rectification”

TYPES OF RECTIFIERS:

· Half wave Rectifier

· Full wave rectifier

1. Centre tap full wave rectifier.

2. Bridge type full bridge rectifier.  

     Comparison of rectifier circuits:

	Parameter
	                      Type of Rectifier

	
	   Half wave                                Full wave             Bridge

	Number of   diodes


	        1
	      2
	4

	PIV of diodes


	      Vm
	     2Vm 
	     Vm

	D.C output voltage
	      Vm/
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	  2Vm/
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	    2Vm/
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	Vdc,at 

no-load                  
	    0.318Vm
	  0.636Vm
	0.636Vm


	Ripple factor
	      1.21
	    0.482
	     0.482

	    Ripple      

   Frequency
	        f 
	      2f
	       2f

	  Rectification

   Efficiency
	      0.406
	    0.812
	   0.812

	  Transformer 

   Utilization

   Factor(TUF)   
	     0.287
	   0.693
	   0.812

	RMS voltage Vrms
	       Vm/2    
	   Vm/√2
	Vm/√2


Full-wave Rectifier:

From the above comparison we came to know that full wave bridge rectifier as more advantages than the other two rectifiers. So, in our project we are using full wave bridge rectifier circuit.

Bridge Rectifier: A bridge rectifier makes use of four diodes in a bridge arrangement to achieve full-wave rectification. This is a widely used configuration, both with individual diodes wired as shown and with single component bridges where the diode bridge is wired internally.

[image: image25]   A bridge rectifier makes use of four diodes in a bridge arrangement as shown in fig(a) to achieve full-wave rectification. This is a widely used configuration, both with individual diodes wired as shown and with single component bridges where the diode bridge is wired internally.
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Fig(A)

Operation:

During positive half cycle of secondary, the diodes D2 and D3 are in forward biased while D1 and D4 are in reverse biased as shown in the fig(b). The current flow direction is shown in the fig (b) with dotted arrows.
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Fig(B)

During negative half cycle of secondary voltage, the diodes D1 and D4 are in forward biased while D2 and D3 are in reverse biased as shown in the fig(c). The current flow direction is shown in the fig (c) with dotted arrows.       

             [image: image29.png]OUTPUT




                                         Fig(C)

Filter:

                     A Filter is a device which removes the a.c component of rectifier output 

but allows the d.c component to reach the load

Capacitor Filter:

      We have seen that the ripple content in the rectified output of half wave rectifier is 121% or that of full-wave or bridge rectifier or bridge rectifier is 48% such high percentages of ripples is not acceptable for most of the applications. Ripples can be removed by one of the following methods of filtering.

(a)  A capacitor, in parallel to the load, provides an easier by –pass for the ripples voltage though it due to low impedance. At ripple frequency and leave the d.c.to appears the load.

(b) An inductor, in series with the load, prevents the passage of the ripple current (due to high impedance at ripple frequency) while allowing the d.c (due to low resistance to d.c)

(c) various combinations of capacitor  and inductor, such  as L-section  filter  [image: image30.png]


 section filter, multiple section filter etc. which make use of  both the properties mentioned in (a) and (b) above. Two cases of capacitor filter, one applied on half wave rectifier and another with full wave rectifier.

Filtering is performed by a large value electrolytic capacitor connected across the DC supply to act as a reservoir, supplying current to the output when the varying DC voltage from the rectifier is falling. The capacitor charges quickly near the peak of the varying DC, and then discharges as it supplies current to the output. Filtering significantly increases the average DC voltage to almost the peak value (1.4 × RMS value). 

To calculate the value of capacitor(C),

                                    C = ¼*√3*f*r*Rl

              Where,

                              f = supply frequency,

                              r = ripple factor,

                             Rl = load resistance

Note: In our circuit we are using 1000µF Hence large value of capacitor is placed to reduce ripples and to improve the DC component. 

Regulator:

 Voltage regulator ICs is available with fixed (typically 5, 12 and 15V) or variable output voltages. The maximum current they can pass also rates them. Negative voltage regulators are available, mainly for use in dual supplies. Most regulators include some automatic protection from excessive current ('overload protection') and overheating ('thermal protection').  Many of the fixed voltage regulator ICs have 3 leads and look like power transistors, such as the 7805 +5V 1A regulator shown on the right. The LM7805 is simple to use. You simply connect the positive lead of your unregulated DC power supply (anything from 9VDC to 24VDC) to the Input pin, connect the negative lead to the Common pin and then when you turn on the power, you get a 5 volt supply from the output pin. 
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78XX:

The Bay Linear LM78XX is integrated linear positive regulator with three terminals. The LM78XX offer several fixed output voltages making them useful in wide range of applications. When used as a zener diode/resistor combination replacement, the LM78XX usually results in an effective output impedance improvement of two orders of magnitude, lower quiescent current. The LM78XX is available in the TO-252, TO-220 & TO-263packages,

Features:

• Output Current of 1.5A

• Output Voltage Tolerance of 5%

• Internal thermal overload protection

• Internal Short-Circuit Limited

• No External Component

• Output Voltage 5.0V, 6V, 8V, 9V, 10V,12V, 15V, 18V, 24V

• Offer in plastic TO-252, TO-220 & TO-263

• Direct Replacement for LM78XX

CAN PROTOCAL

CAN is a multi-master broadcast serial bus standard for connecting electronic control units (ECUs).

Each node is able to send and receive messages, but not simultaneously: a message (consisting primarily of an ID usually chosen to identify the message-type/sender  and up to eight message bytes) is transmitted serially onto the bus, one bit after another  this signal pattern codes the message (in NRZ) and is sensed by all nodes.

The devices that are connected by a CAN network are typically sensors, actuators and control devices. A CAN message never reaches these devices directly, but instead a host processor and a CAN controller are needed between these devices and the bus.

If the bus is free, any node may begin to transmit. If two or more nodes begin sending messages at the same time, the message with the more dominant ID (which has more dominant bits, i.e., bit 0) will overwrite other nodes' less dominant IDs, so that eventually (after this arbitration on the ID) only the dominant message remains and is received by all nodes.

Each node requires

· a host processor 

· The host processor decides what received messages mean and which messages it wants to transmit itself 

· Sensors, actuators and control devices can be connected to the host processor (if desired) 

· a CAN controller (hardware with a synchronous clock) 

· Receiving: the CAN controller stores received bits (one by one) from the bus until an entire message is available, which can then be fetched by the host processor (usually after the CAN controller has triggered an interrupt) 

· Sending: the host processor stores its transmit messages into a CAN controller, which transmits the bits serially onto the bus 

· a Transceiver (possibly integrated into the CAN controller) 

· Receiving: it adapts signal levels from the bus to levels that the CAN controller expects and has protective circuitry that protect the CAN controller 

· Sending: it converts the transmit-bit signal received from the cAN Controller into a signal that is sent onto the bus. 

Bit rates up to 1 Mbit/s are possible at network lengths below 40 m. Decreasing the bit rate allows longer network distances (e.g. 125 kbit/s at 500 m).

The CAN data link layer protocol is standardized in ISO 11898-1 (2003). This standard describes mainly the data link layer — composed of the logical link control (LLC) sublayer and the media access control (MAC) sublayer — and some aspects of the physical layer of the OSI reference model. All the other protocol layers are the network designer's choice.

CAN  CONTROLLER
[image: image32.emf]Features

• Implements CAN V2.0B at 1 Mb/s:

- 0 - 8 byte length in the data field

- Standard and extended data and remote

frames

• Receive buffers, masks and filters:

- Two receive buffers with prioritized message

storage

- Six 29-bit filters

- Two 29-bit masks

• Data byte filtering on the first two data bytes

(applies to standard data frames)

• Three transmit buffers with prioritizaton and abort

features.

• High-Speed SPI™ Interface (10 MHz):

- SPI modes 0,0 and 1,1

• One-shot mode ensures message transmission is

attempted only one time

• Clock out pin with programmable prescaler:

- Can be used as a clock source for other

device(s)

• Start-of-Frame (SOF) signal is available for

monitoring the SOF signal:

- Can be used for time-slot-based protocols

and/or bus diagnostics to detect early bus

degredation

• Interrupt output pin with selectable enables

• Buffer Full output pins configurable as:

- Interrupt output for each receive buffer

- General purpose output

• Request-to-Send (RTS) input pins individually

configurable as:

- Control pins to request transmission for each

transmit buffer

- General purpose inputs

• Low power CMOS technology:

- Operates from 2.7V - 5.5V

- 5 mA active current (typical)

- 1 μA standby current (typical) (Sleep mode)

• Temperature ranges supported:

- Industrial (I): -40°C to +85°C

- Extended (E): -40°C to +125°C

Description

Microchip Technology’s MCP2515 is a stand-aloneController Area Network (CAN)controller that implements the CAN specification, version 2.0B. It is capable

of transmitting and receiving both standard andextended data and remote frames. The MCP2515 hastwo acceptance masks and six acceptance filters thatare used to filter out unwanted messages, therebyreducing the host MCUs overhead. The MCP2515interfaces with MCUs via an industry standard Serial

Peripheral Interface (SPI™).

 DEVICE OVERVIEW

The MCP2515 is a stand-alone CAN controllerdeveloped to simplify applications that requireinterfacing with a CAN bus. A simple block diagram ofthe MCP2515 is shown in Figure 1-1. The deviceconsists of three main blocks:

1. The CAN module, which includes the CAN protocolengine, masks, filters, transmits andreceives buffers

2. The control logic and registers that are used toconfigure the device and its operation

3. The SPI protocol blockAn example system implementation using the device is

shown in Figure 1-2.

1.1 CAN Module

1.2 The CAN module handles all functions for receivingand transmitting messages on the CAN bus. Messagesare transmitted by first loading the appropriatemessage buffer and control registers. Transmission isinitiated by using control register bits, via the SPIinterface or by using the transmit enable pins. Statusand errors can be checked by reading the appropriateregisters. Any message detected on the CAN bus ischecked for errors and then matched against the userdefinedfilters to see if it should be movedinto one of  two receive buffers.

1.3 Control Logic

The control logic block controls the setup and operationof the MCP2515 by interfacing to the other blocks inorder to pass information and control.
Interrupt pins are provided to allow greater systemflexibility. There is one multi-purpose interrupt pin, aswell as specific interrupt pins, for each of the receiveregisters that can be used to indicate a valid messagehas been received and loaded into one of the receivebuffers. Use of the specific interrupt pins is optional.The general purpose interrupt pin, as well as status

registers (accessed via the SPI interface), can also beused to determine when a valid message has beenreceived.

Additionally, there are three pins available to initiateimmediate transmission of a message that has beenloaded into one of the three transmit registers. Use of

these pins is optional and initiating messagetransmission can also be accomplished by utilizingcontrol registers, accessed via the SPI interface.

1.4 SPI Protocol Block

The MCU interfaces to the device via the SPI interface.Writing to, and reading from, all registers isaccomplished using standard SPI read and writecommands in addition to specialized SPI commands

CAN TRANSCEIVER:
Features

• Supports 1 Mb/s operation

• Implements ISO-11898 standard physical layer

requirements

• Suitable for 12V and 24V systems

• Externally-controlled slope for reduced RFI

emissions

• Detection of ground fault (permanent dominant)

on TXD input

• Power-on reset and voltage brown-out protection

• An unpowered node or brown-out event will not

disturb the CAN bus

• Low current standby operation

• Protection against damage due to short-circuit

conditions (positive or negative battery voltage)

• Protection against high-voltage transients

• Automatic thermal shutdown protection

• Up to 112 nodes can be connected

• High noise immunity due to differential bus

implementation

• Temperature ranges:

- Industrial (I): -40°C to +85°C

- Extended (E): -40°C to +125°C 


1.0 DEVICE OVERVIEW

The MCP2551 is a high-speed CAN, fault-tolerantdevice that serves as the interface between a CANprotocol controller and the physical bus. The MCP2551provides differential transmit and receive capability forthe CAN protocol controller and is fully compatible withthe ISO-11898 standard, including 24V requirements. It

will operate at speeds of up to 1 Mb/s.

Typically, each node in a CAN system must have adevice to convert the digital signals generated by aCAN controller to signals suitable for transmission over

the bus cabling (differential output). It also provides abuffer between the CAN controller and the high-voltagespikes that can be generated on the CAN bus by

outside sources (EMI, ESD, electrical transients, etc.).

1.1 Transmitter Function
The CAN bus has two states: Dominant andRecessive. A dominant state occurs when the

differential voltage between CANH and CANL isgreater than a defined voltage (e.g.,1.2V). A recessivestate occurs when the differential voltage is less than a

defined voltage (typically 0V). The dominant andrecessive states correspond to the low and high stateof the TXD input pin, respectively. However, a dominant

state initiated by another CAN node will override arecessive state on the CAN bus.

1.1.1 MAXIMUM NUMBER OF NODES

The MCP2551 CAN outputs will drive a minimum loadof 45Ω, allowing a maximum of 112 nodes to beconnected (given a minimum differential input

resistance of 20 kΩ and a nominal termination resistorvalue of 120Ω).

1.2 Receiver Function

The RXD output pin reflects the differential bus voltagebetween CANH and CANL. The low and high states ofthe RXD output pin correspond to the dominant and

recessive states of the CAN bus, respectively.

1.3 Internal Protection

CANH and CANL are protected against battery shortcircuitsand electrical transients that can occur on theCAN bus. This feature prevents destruction of thetransmitter output stage during such a fault condition.The device is further protected from excessive current

loading by thermal shutdown circuitry that disables theoutput drivers when the junction temperature exceedsa nominal limit of 165°C. All other parts of the chip

remain operational and the chip temperature is lowereddue to the decreased power dissipation in thetransmitter outputs. This protection is essential toprotect against bus line short-circuit-induced damage.

1.4 Operating Modes

The RS pin allows three modes of operation to beselected:

• High-Speed

• Slope-Control

• Standby

These modes are summarized in Table 1-1.

When in High-speed or Slope-control mode, the driversfor the CANH and CANL signals are internally regulatedto provide controlled symmetry in order to minimizeEMI emissions.Additionally, the slope of the signal transitions onCANH and CANL can be controlled with a resistor
connected from pin 8 (RS) to ground, with the slope

proportional to the current output at RS, furtherreducing EMI emissions.

1.4.1 HIGH-SPEED

High-speed mode is selected by connecting the RS pinto VSS. In this mode, the transmitter output drivers havefast output rise and fall times to support high-speed

CAN bus rates.

1.4.2 SLOPE-CONTROL

Slope-control mode further reduces EMI by limiting therise and fall times of CANH and CANL. The slope, orslew rate (SR), is controlled by connecting an external

resistor (REXT) between RS and VOL (usually ground).The slope is proportional to the current output at the RSpin. Since the current is primarily determined by the slope-control resistance value REXT, a certain slew rateis achieved by applying a respective resistance.

Figure 1-1 illustrates typical slew rate values as afunction of the slope-control resistance value.

1.4.3 STANDBY MODE

The device may be placed in standby or “SLEEP” modeby applying a high-level to RS. In SLEEP mode, thetransmitter is switched off and the receiver operates at

a lower current. The receive pin on the controller side(RXD) is still functional but will operate at a slower rate.The attached microcontroller can monitor RXD for CAN

bus activity and place the transceiver into normaloperation via the RS pin (at higher bus rates, the firstCAN message may be lost).

.
TEMPERATURE SENSING CIRCUIT (temperature sensor):

The methods of temperature measurement may be divided into two main classes according as the exchange of heat between the testing body and the hot system takes place by contact or by radiation across a space.   In the contact methods, thermometers or thermocouples are used and they are immersed in solids or liquids.  The thermodynamic equilibrium between the hot body and the testing body is established by material contact.   In the non-contact methods, the thermodynamic equilibrium is established by the radiation emitted as excited atom and molecules in the hot body return to the ground state.

THERMISTOR:

Description and working

The word thermistor is an acronym for thermal resistor, i.e., a temperature sensitive resistor. It is used to detect very small changes in temperature. The variation in temperature is reflected through appreciable variation of the resistance of the device. Thermistors with both negative-temperature-coefficients (NTC) and positive temperature coefficient (PTC) are available, but NTC thermistors are more common. The negative-temperature coefficient means that the resistance increases with the increase in temperature.

The NTC thermistors are manufactured by sintering which is a process in which powdered materials are fused together by the application of heat semiconductor ceramic materials prepared from mixtures of metallic oxides of cobalt, nickel, manganese etc. These materials have high negative temperature coefficient. The PTC thermistors are made from doped barium titanate semi conducting material. This material has a very large change in resistance for a small change in temperature. In this project NTC thermistor is used.

Thermistors are manufactured in the form of beads, probes, disc, washers and rods. The beads are made in diameter ranging from 0.15mm to 2.5mm. These are useful where temperature sensing must be done in very limited spaces. Sealing thermistor beads in glass rods upto 25mm in diameter forms the probes. These are more rugged than beads and work well in liquids.


Fig – 3.3 - SCHEMATIC SYMBOL

The discs and washers are made to meet certain industrial requirements. The discs are used in moderate power applications in conjunction with time response applications. The rods and washers are used for high power applications. Figure shows the schematic symbol of a thermistor.

THERMISTOR CHARACTERISTICS:

Figure shows the thermistor characteristic (temperature-resistance characteristic) for the NTC and PTC thermistors. It may be noted that NTC thermistor has a resistance of about 10kilo ohms and 100kilo ohms at –50 C to 150 C respectively. It means that a temperature change of 200 C has resulted in a 100:1 change in resistance
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                            Fig- 3.4: -THERMISTOR CHARACTERISTIC         

In case of PTC thermistor, the curve rises rapidly. The temperature where the resistance increases rapidly is called switching point. The switching point temperature depends upon the particular type of PTC thermistor. The typical values of the switching point temperature may range from 30 C to 160 C.

THERMISTOR APPLICATIONS:

Thermistors are extensively used in industrial, commercial, medical and household applications. Some of the important applications of thermistors are:

1. Temperature measurement and control.

2. Liquid level measurement.

3. Temperature compensation in electronic circuits.

4. Flow rate measurement.

. 

ADC:

Theory:                                                         
ADC is short for Analog Digital Converter, Sometimes called a A-D or A to D Converter. An ADC is a device that converts a continuous analog signal to a multi-level digital signal without altering its content. The signals that are monitored are sounds, movement, and temperature into binary code for the PC.

(or)

Analog to digital (A/D, ADC) converters are electrical circuit devices that convert continuous signals, such as voltages or currents, from the analog domain to the digital domain where the signals are represented by numbers.

Most processing equipment today are digital in nature, and they work with signals which are binary valued. In a digital or binary representation, a signal is represented by a word, which is composed of a finite number of bits. The processing of signals is preferably carried out in the digital domain because digital processing is fast, accurate and reliable. Analog to digital converters are widely used for converting analog signals to corresponding digital signals for many electronic circuits. Analog to digital converters allow the use of sophisticated digital signal processing systems to process analog signals, which are common in the real world. Many modern electronic systems require conversion of signals from analog to digital or from digital to analog form. Circuits for performing these functions are now required in numerous common consumer devices such as digital cameras, cellular telephones, wireless data network equipment, audio devices such as MP3 players, and video equipment such as digital video disk (DVD) players, high definition digital television (HDTV), and numerous other products. Analog to digital converters (ADC's) form an essential link in the signal processing pathway at the interface between the analog and digital domains. Advances in ADC technology have increased the speed, lowered the cost, and reduced the power requirements of analog to digital converters, and resulted in a proliferation of ADC applications

                        Conversion involves quantizing and encoding. Quantizing means partitioning the analog signal range into a number of discrete quanta and determining to which quantum the input signal belongs. Encoding means assigning a unique digital code to each quantum and determining the code that corresponds to the input signal. The most common system is binary, in which there are 2n quanta (where n is some whole number), numbered consecutively; the code is a set of n physical two-valued levels or bits (1 or 0) corresponding to the binary number associated with the signal quantum.

                  The illustration shows a typical three-bit binary representation of a range of input signals, partitioned into eight quanta. For example, a signal in the vicinity of 3/8; full scale (between 5/16 and 7/16) will be coded 011 (binary 3).

[image: image33.png]000 001010 011 100 101 110 111 _binary code
R S S S S S )
S L O B

range

(full scaio)





A three-bit binary representation of a range of input signals.


There are four commonly used ADC’s:

· Parallel converter
· Successive approximation ADC
· Voltage-to-Frequency ADC 
· Integrating ADC
Applications of ADC:

· Digital camera or scanner uses A/D converters to transform the variable charges in CCD and CMOS chips into the binary data that represent pixels.
· Cell phone and digital desk phone has an ADC converter that converts the pressure of sound waves into PCM code Etc.



Liquid Crystal Display

             Liquid crystal displays (LCDs) have materials which combine the properties of both liquids and crystals. Rather than having a melting point, they have a temperature range within which the molecules are almost as mobile as they would be in a liquid, but are grouped together in an ordered form similar to a crystal.


An LCD consists of two glass panels, with the liquid crystal material sand witched in between them. The inner surface of the glass plates are coated with transparent electrodes which define the character, symbols or patterns to be displayed polymeric layers are present in between the electrodes and the liquid crystal, which makes the liquid crystal molecules to maintain a defined orientation angle.


One each polarisers are pasted outside the two glass panels. These polarisers would rotate the light rays passing through them to a definite angle, in a particular direction


When the LCD is in the off state, light rays are rotated by the two polarisers and the liquid crystal, such that the light rays come out of the LCD without any orientation, and hence the LCD appears transparent.


When sufficient voltage is applied to the electrodes, the liquid crystal molecules would be aligned in a specific direction. The light rays passing through the LCD would be rotated by the polarisers, which would result in activating / highlighting the desired characters.


The LCD’s are lightweight with only a few millimeters thickness. Since the LCD’s consume less power, they are compatible with low power electronic circuits, and can be powered for long durations.


The LCD s doesn’t generate light and so light is needed to read the display. By using backlighting, reading is possible in the dark. The LCD’s have long life and a wide operating temperature range.


Changing the display size or the layout size is relatively simple which makes the LCD’s more customer friendly.


The LCDs used exclusively in watches, calculators and measuring instruments are the simple seven-segment displays, having a limited amount of numeric data. The recent advances in technology have resulted in better legibility, more information displaying capability and a wider temperature range. These have resulted in the LCDs being extensively used in telecommunications and entertainment electronics. The LCDs have even started replacing the cathode ray tubes (CRTs) used for the display of text and graphics, and also in small TV applications.

                                        This section describes the operation modes of LCD’s then describe how to program and interface an LCD to 8051 using Assembly and C.

LCD operation:





In recent years the LCD is finding widespread use replacing LED s (seven-segment LED s or other multi-segment LED s).This is due to the following reasons:

1. The declining prices of LCDs.

2. The ability to display numbers, characters and graphics. This is in contrast to LED which is limited to numbers and a few characters.

3. Incorporation of a refreshing controller into the LCD, there by relieving the CPU of the task of refreshing the LCD. In the case of LED s, they must be refreshed by the CPU to keep on displaying the data.

4. Ease of programming for characters and graphics.

LCD pin description:  

                                     The LCD discussed in this section has 14 pins. The function of each pin is given in table.
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TABLE 1: Pin description for LCD
	Pin
	symbol
	I/O
	Description

	1
	Vss
	--
	Ground

	2
	Vcc
	--
	+5V power supply

	3
	VEE
	--
	Power supply to control contrast

	4
	RS
	I
	RS=0 to select command register

RS=1 to select  

data register

	5
	R/W
	I
	R/W=0 for write

R/W=1 for  read

	6
	E
	I/O
	Enable

	7
	DB0
	I/O
	The 8-bit data bus

	8
	DB1
	I/O
	The 8-bit data bus

	9
	DB2
	I/O
	The 8-bit data bus

	10
	DB3
	I/O
	The 8-bit data bus

	11
	DB4
	I/O
	The 8-bit data bus

	12
	DB5
	I/O
	The 8-bit data bus

	13
	DB6
	I/O
	The 8-bit data bus

	14
	DB7
	I/O
	The 8-bit data bus


   The LCD can display a character successfully by placing the  

1.  Data in Data Register

2. Command in Command Register of LCD

1. Data corresponds to the ASCII value of the character to be printed. This can be done by placing the ASCII value on the LCD Data lines and selecting the Data Register of the LCD by selecting the RS (Register Select) pin.

2. Each and every display location is accessed and controlled by placing respective command on the data lines and selecting the Command Register of LCD by selecting the (Register Select) RS pin.

The commonly used commands are shown below with their operations.

TABLE 2: LCD Command Codes 

	Code (hex)
	Command to LCD Instruction Register

	1 
	Clear display screen

	2
	Return home

	4
	Decrement cursor

	6
	Increment cursor

	5
	Shift display right

	7
	Shift display left  

	8
	Display off, cursor off

	A
	Display off, cursor on

	C
	Display on, cursor off

	E
	Display on, cursor on

	F
	Display on, cursor blinking

	10
	Shift cursor position to left

	14
	Shift cursor position to right

	18
	Shift the entire display to the left

	1C
	Shift the entire display to the right

	80
	Force cursor to beginning of 1st line


	C0
	Force cursor to beginning of 2nd line

	38
	2 lines and 5x7 matrix


Uses:               The LCDs used exclusively in watches, calculators and measuring instruments are the simple seven-segment displays, having a limited amount of numeric data. The recent advances in technology have resulted in better legibility, more information displaying capability and a wider temperature range. These have resulted in the LCDs being extensively used in telecommunications and entertainment electronics.                                                                                         

                                    So in this project, the LCD is used to display the instantaneous information. The information may be prompting or alerting or instructing the user.

H-BRIDGE:
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                                            DC motors are typically controlled by using a transistor configuration called an "H-bridge". This consists of a minimum of four mechanical or solid-state switches, such as two NPN and two PNP transistors. One NPN and one PNP transistor are activated at a time. Both NPN and PNP transistors can be activated to cause a short across the motor terminals, which can be useful for slowing down the motor from the back EMF it creates.

Basic Theory

H-bridge. Sometimes called a "full bridge" the H-bridge is so named because it has four switching elements at the "corners" of the H and the motor forms the cross bar. 

The key fact to note is that there are, in theory, four switching elements within the bridge. These four elements are often called, high side left, high side right, low side right, and low side left (when traversing in clockwise order).

The switches are turned on in pairs, either high left and lower right, or lower left and high right, but never both switches on the same "side" of the bridge. If both switches on one side of a bridge are turned on it creates a short circuit between the battery plus and battery minus terminals. If the bridge is sufficiently powerful it will absorb that load and your batteries will simply drain quickly. Usually however the switches in question melt.

To power the motor, you turn on two switches that are diagonally opposed. In the picture to the right, imagine that the high side left and low side right switches are turned on. 

The current flows and the motor begins to turn in a "positive" direction. Turn on the high side right and low side left switches, then Current flows the other direction through the motor and the motor turns in the opposite direction.

Actually it is just that simple, the tricky part comes in when you decide what to use for switches. Anything that can carry a current will work, from four SPST switches, one DPDT switch, relays, transistors, to enhancement mode power MOSFETs.

One more topic in the basic theory section, quadrants. If each switch can be controlled independently then you can do some interesting things with the bridge, some folks call such a bridge a "four quadrant device" (4QD get it?). If you built it out of a single DPDT relay, you can really only control forward or reverse. You can build a small truth table that tells you for each of the switch's states, what the bridge will do. As each switch has one of two states, and there are four switches, there are 16 possible states. However, since any state that turns both switches on one side on is "bad" (smoke issues forth: P), there are in fact only four useful states (the four quadrants) where the transistors are turned on.

	High Side Left
	High Side Right
	Low Side Left
	Low Side Right
	Quadrant Description

	On
	Off
	Off
	On
	Forward Running

	Off
	On
	On
	Off
	Backward Running

	On
	On
	Off
	Off
	Braking

	Off
	Off
	On
	On
	Braking


The last two rows describe a maneuver where you "short circuit" the motor which causes the motors generator effect to work against itself. The turning motor generates a voltage which tries to force the motor to turn the opposite direction. This causes the motor to rapidly stop spinning and is called "braking" on a lot of H-bridge designs.

Of course there is also the state where all the transistors are turned off. In this case the motor coasts freely if it was spinning and does nothing if it was doing nothing.

Implementation

1. Using Relays: 
A simple implementation of an H Bridge using four SPST relays is shown. Terminal A is High Side Left, Terminal B is High Side Right, Terminal C is Low Side Left and Terminal D is Low Side Right. The logic followed is according to the table above.

Warning: Never turn on A and C or B and D at the same time. This will lead to a short circuit of the battery and will lead to failure of the relays due to the large current. 
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2. Using Transistors: 
We can better control our motor by using transistors or Field Effect Transistors (FETs). Most of what we have discussed about the relays H-Bridge is true of these circuits. See the diagram showing how they are connected. You should add diodes across the transistors to catch the back voltage that is generated by the motor's coil when the power is switched on and off. This fly back voltage can be many times higher than the supply voltage!

For information on building an H-Bridge using Transistors, have a look here.
Warning: If you don't use diodes, you could burn out your transistors. Also the same warning as in the diode case. Don't turn on A and C or B and D at the same time.
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Transistors, being a semiconductor device, will have some resistance, which causes them to get hot when conducting much current. This is called not being able to sink or source very much power, i.e.: Not able to provide much current from ground or from plus voltage.

Mosfets are much more efficient, they can provide much more current and not get as hot. They usually have the fly back diodes built in so you don't need the diodes anymore. This helps guard against fly back voltage frying your ICs.

To use Mosfets in an H-Bridge, you need P-Channel Mosfets on top because they can "source" power, and N-Channel Mosfets on the bottom because then can "sink" power.

It is important that the four quadrants of the H-Bridge circuits be turned on and off properly. When there is a path between the positive and ground side of the H-Bridge, other than through the motor, a condition exists called "shoot through". This is basically a direct short of the power supply and can cause semiconductors to become ballistic, in circuits with large currents flowing. There are H-bridge chips available that are much easier, and safer, to use than designing your own H-Bridge circuit.

1. Using H-Bridge Devices 

The L293 has 2 H-Bridges (actually 4 Half H-Bridges), can provide about 1 amp to each and occasional peak loads to 2 amps.

The L298 has 2 h-bridges on board, can handle 1amp and peak current draws to about 3amps. The LMD18200 has one h-bridge on board, can handle about 2 or 3 amps and can handle a peak of about 6 amps. There are several more commercially designed H-Bridge chips as well.

Once a Half H-bridge is enabled, it truth table is as follows:

	INPUT
A
	OUTPUT
Y

	L
	L

	H
	H


So you just give a High level when you want to turn the Half H-Bridge on and Low level when you want to turn it off. When the Half H-Bridge is on, the voltage at the output is equal to Vcc2.If you want to make a Full H-Bridge, you connect the motor (or the load) between the outputs of two Half H-Bridges and the inputs will be the two inputs of the Half H-Bridges.

Suppose we have connected Half H-Bridges 1 and 2 to form a Full H-Bridge. Now the truth table is as follows:

	INPUT
1A
	INPUT
2A
	OUTPUT
1Y
	OUTPUT
2Y
	Description

	L
	L
	L
	L
	Braking (both terminals of motor are Gnd)

	L
	H
	L
	H
	Forward Running

	H
	L
	H
	L
	Backward Running

	H
	H
	H
	H
	Braking (both terminals of motor at Vcc2


2) L293D Motor Driver IC: 

Since two motors are used to drive The back wheels of the robot independently, there is a need for Two H-bridges. Instead of implementing the above H-bridge controlCircuit twice, an alternative is to use an integrated circuit (IC), which Provides more than one

 H-bridges. One such IC is L293D, which has  2 H-Bridges in it. It can supply 600Ma continuous and 1.2A peak Currents. It is suitable for switching applications up to 5 kHz. These  Features make it ideal for our application. Another option is to use IC L298, which can drive 2A continually and 3A peak currents. The Diagram of L293D is shown in Figure 2It can be observed from the figure that L293D has a similar configuration to the circuit in

Figure 1


Figure 1

3) Motor Driver Connections: The motor driver requires 2 control

inputs for each motor. Since we drive 2 motors, we need 4 controls


Inputs from the microcontroller. Since it has many pins which can be configured as outputs, there are many options for implementation.For example, in our robot the last 4 bits of Port B (RB4, RB5, RB6,RB7 - Pins 37 to 40) are used to control the rotation direction of the motors . The enable pins of the motor driver are connected to the PWM outputs of the microcontroller (Pins 16and 17). This is because, as was mentioned above, by changing the width of the pulse (implying changing the enable time of the driver) one can change the speed of the motor. The truth table for motor driver is as shown in Table II, where H = high, L = low, and Z =high output impedance state.

Since the motors are reverse aligned, in order to have the robot Move forward they must be configured such that one of them turns forward and the other one turns backward. In case of any requirement for the robot to move backward, it is sufficient to just reverse the

TABLE II

THE TRUTH TABLE OF THE MOTOR DRIVER

	input
	enable
	output

	H
	H
	H

	L
	H
	L

	H
	L
	z

	L
	L
	z


TABLE III

DRIVER CONTROL INPUTS

	Direction
	Input 1
	Input 2
	Input 3
	Input 4

	Forward
	H
	L
	L
	H

	Backward 
	L
	H
	H
	L


Outputs of the control pins. For example, in our robot while moving forward, inputs of the motor driver have states shown in the first row Of Table III, whereas for backward movement, the states shown in the second row of Table III is applied.

DC Motor 

                        DC motors are configured in many types and sizes, including brush less, servo, and gear motor types. A motor consists of a rotor and a permanent magnetic field stator. The magnetic field is maintained using either permanent magnets or electromagnetic windings. DC motors are most commonly used in variable speed and torque.
                         Motion and controls cover a wide range of components that in some way are used to generate and/or control motion. Areas within this category include bearings and bushings, clutches and brakes, controls and drives, drive components, encoders and resolves, Integrated motion control, limit switches, linear actuators, linear and rotary motion components, linear position sensing, motors (both AC and DC motors), orientation position sensing, pneumatics and pneumatic components, positioning stages, slides and guides, power transmission (mechanical), seals, slip rings, solenoids, springs. 

                         Motors are the devices that provide the actual speed and torque in a drive system.  This family includes AC motor types (single and multiphase motors, universal, servo motors, induction, synchronous, and gear motor) and DC motors (brush less, servo motor, and gear motor) as well as linear, stepper and air motors, and motor contactors and starters.

                          In any electric motor, operation is based on simple electromagnetism. A current-carrying conductor generates a magnetic field; when this is then placed in an external magnetic field, it will experience a force proportional to the current in the conductor, and to the strength of the external magnetic field. As you are well aware of from playing with magnets as a kid, opposite (North and South) polarities attract, while like polarities (North and North, South and South) repel. The internal configuration of a DC motor is designed to harness the magnetic interaction between a current-carrying conductor and an external magnetic field to generate rotational motion.

             Let's start by looking at a simple 2-pole DC electric motor (here red represents a magnet or winding with a "North" polarization, while green represents a magnet or winding with a "South" polarization).

[image: image38.png]



Fig 25: Block Diagram of the DC motor

Every DC motor has six basic parts -- axle, rotor (a.k.a., armature), stator, commutator, field magnet(s), and brushes. In most common DC motors (and all that Beamers will see), the external magnetic field is produced by high-strength permanent magnets1. The stator is the stationary part of the motor -- this includes the motor casing, as well as two or more permanent magnet pole pieces. The rotor (together with the axle and attached commutator) rotates with respect to the stator. The rotor consists of windings (generally on a core), the windings being electrically connected to the commutator. The above diagram shows a common motor layout -- with the rotor inside the stator (field) magnets.

               The geometry of the brushes, commutator contacts, and rotor windings are such that when power is applied, the polarities of the energized winding and the stator magnet(s) are misaligned, and the rotor will rotate until it is almost aligned with the stator's field magnets. As the rotor reaches alignment, the brushes move to the next commutator contacts, and energize the next winding. Given our example two-pole motor, the rotation reverses the direction of current through the rotor winding, leading to a "flip" of the rotor's magnetic field, and driving it to continue rotating.

                      In real life, though, DC motors will always have more than two poles (three is a very common number). In particular, this avoids "dead spots" in the commutator. You can imagine how with our example two-pole motor, if the rotor is exactly at the middle of its rotation (perfectly aligned with the field magnets), it will get "stuck" there. Meanwhile, with a two-pole motor, there is a moment where the commutator shorts out the power supply (i.e., both brushes touch both commutator contacts simultaneously). This would be bad for the power supply, waste energy, and damage motor components as well. Yet another disadvantage of such a simple motor is that it would exhibit a high amount of torque” ripple" (the amount of torque it could produce is cyclic with the position of the rotor).

                                                 [image: image39.png]



Fig 26: Block Diagram of the DC motor having two poles only

                  So since most small DC motors are of a three-pole design, let's tinker with the workings of one via an interactive animation (JavaScript required):
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Fig 27: Block Diagram of the DC motor having Three poles

You'll notice a few things from this -- namely, one pole is fully energized at a time (but two others are "partially" energized). As each brush transitions from one commutator contact to the next, one coil's field will rapidly collapse, as the next coil's field will rapidly charge up (this occurs within a few microsecond). We'll see more about the effects of this later, but in the meantime you can see that this is a direct result of the coil windings' series wiring:
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Fig 28: Internal Block Diagram of the Three pole DC motor 

           There's probably no better way to see how an average dc motor is put together, than by just opening one up. Unfortunately this is tedious work, as well as requiring the destruction of a perfectly good motor.  This is a basic 3-pole dc motor, with 2 brushes and three commutator contacts.

Circuit Description:

In the above project discussed as far, we are not sure about actually the idea regarding the project because , till now we had discussed about the different components used in the project and their specifications, characteristics etc. but now we come across the flow of data or the sequence of the connections regarding these components with the microcontroller.


In this flow the place goes to the power supply circuit and which is also used any application where ever the controller is necessary. That means power supply plays a major role in any project. It is easy and simple either to built or learn. When the question comes, “what are the major components used in the circuit ……?” Immediately the answer is “It consists of four important components such as 





- A transformer which is step down





- A rectifier bridge.





- A Electrolytic Capacitor and 





- The voltage regulator”

      The total operation and the action of the power supply circuit as already discussed earlier.

The sensors will send the information regarding field about the parameters such as temperature to the microcontroller by using ADC connected to the sensors. The microcontroller will send the information to the can controller receiver by can transceiver then the other transceiver will receive the details of temperature and it is displayed in the LCD. In the same way we can control the ABS also. 

SOFTWARE:
ABOUT SOFTWARE

Software’s used are:

*Express PCB for lay out design

*Express SCH for schematic design

· HELLO is a simple program that prints the string "Hello World" using the Serial Interface.

· MEASURE is a data acquisition system for analog and digital systems.

· TRAFFIC is a traffic light controller with the RTX Tiny operating system.

· SIEVE is the SIEVE Benchmark.

· DHRY is the Dhrystone Benchmark.

· WHETS is the Single-Precision Whetstone Benchmark.

SOFTWARE

[image: image42.png]MPLAB IDE is a Windows® Operating System (OS) software program that runs on a
PC to develop applications for Microchip microcontrollers and digital signal controllers.

Itis called an Integrated Development Environment, or IDE, because it provides a sin-
dle integrated "environment” to develop code for embedded microcontrollers. Experi-

enced embedded systems designers may want to skip ahead to



[image: image43.png]In a development environment, the execution of the code is tested on a debugger. The
debugger can be a software program that simulates the operation of the microcontroller
for testing, or it can be special instrumentation to analyze the program as it executes in
the application.



     [image: image44.png]The project manager organizes the files to be edited and other associated files so they
canbe sent to the language tools for assembly or compilation, and ultimately to a linker.
The linker has the task of placing the object code fragments from the assembler, com-
piler and libraries into the proper memory areas of the embedded controller, and ensure
that the modules function with each other (or are *linked"). This entire operation from
assembly and compilation through the link process is called a project “build”. From the
MPLAB IDE project manager, properties of the language tools can be invoked differ-
ently for each file, if desired, and a build process integrates all of the language tools
operations.



[image: image45.png]Simulators are built into MPLAB IDE so a program can be tested without any additional
hardware. A simulator is a software debugger, and the debugger functions for the sim-
ulator are almost identical to the hardware debuggers. allowing a new tool to be learned
with ease. Usually a simulator runs somewhat slower than an actual microcontroller,
since the CPU in the PC i being used to simulate the operations of the microcontroller.
In the case of MPLAB IDE, there are many simulators for each of the PIC MCU and the
dsPIC DSC processors.





[image: image46.png]171 MPLAB IDE Built-in Components

The built-in components consist of:
+ Project Manager

The project manager provides integration and communication between the IDE and the
language tools.

+ Editor

The editor is a full-featured programmer's text editor that also serves as a window into
the debugger.

+ Assembler/Linker and Language Tools

The assembler can be used stand-alone to assemble a single file, or can be used with
the linker to build a project from separate sourcefiles, libraries and recompiled objects.
The linker is responsible for positioning the compiled code into memory areas of the
target microcontroller.

+ Debugger

The Microchip debugger allows breakpoints, single stepping, watch windows and all
the features of a modem debugger for the MPLAB IDE. It works in conjunction with the

editor to reference information from the target being debugged back to the source
code.




[image: image47.png]« Execution Engines
There are software simulators in MPLAB DE for all PIC MCU and dsPIC DSC devices.
These simulators use the PC to simulate the instructions and some peripheral functions
of the PIC MCU and dsPIC DSC devices. Optional in-circuit emulators and in-circuit
debuggers are also available to test code as it runs i the applications hardware.




[image: image48.png]In order to create code that is executable by the target PIC MCU, source files need to
be put into a project. The code can then be built into executable code using selected
language tools (assemblers, compilers, linkers, etc.). In MPLAB IDE, the project man-
ager controls this process.

Al projects will have these basic steps:
1. Select Device

The capabilities of MPLAB IDE vary according to which device is selected.
Device selection should be completed before starting a project.

2. Create Project
MPLAB IDE Project Wizard will be used to Create a Project.
3. Select Language Tools

In the Project Wizard the language tools will be selected. For this tutorial, the
built-in assembler and linker will be used. For other projects, one of the Microchip
compilers or other third party tools might be selected.

4. Put Files in Project



[image: image49.png]Put Files in Project

Two files will be put into the project, a template file and a linker script. Both of
these files exist in sub-folders within the MPLAB IDE folder. It is easy to get
started using these two files.

Create Code

Some code will be added to the template file to send an incrementing value out
an 1/0 port.

Build Project

The project will be built — causing the source files to be assembled and linked
into machine code that can run on the selected PIC MCU.

Test Code with Simulator
Finally, the code will be tested with the simulator.




[image: image50.png]CREATING THE PROJECT




[image: image51.png]The next step is to create a project using the Project Wizard. A project is the way the
files are organized to be compiled and assembled. We will use a single assembly file
for this project and a linker script. Choose Project>Project Wizard.

From the Welcome dialog, click on Next> to advance.
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[image: image54.png]SETTING UP LANGUAGE TOOLS
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[image: image56.png]NAMING THE PROJECT




[image: image57.png]Step Three of the wizard allows you to name the new project and put it into a folder.
This sample project will be called ¢\ Projects\MyProject. Type this into the text
box and then click Next>. You will be prompted to create the directory since it does not

exist. Click OK.
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[image: image59.png]ADDING FILES TO THE PROJECT
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[image: image62.png]After pressing the Finish button, review the Project Window on the MPLAB IDE
desktop. It should look like Figure 4-9. If the Project Window is not open, select
View>Project.
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[image: image64.png]BUILDING THE PROJECT




[image: image65.png]From the Project menu, we can assemble and link the current files. They don't have
any of our code in them yet, but this ensures that the project is set up correctly.

To build the project, select either:

+ Project>Build All

+ Right click on the project name in the project window and select Build All

+ Click the Build All icon on the Project toolbar. Hover the mouse over icons to see
pop-up text of what they represent.

The Output window shows the result of the build process. There should be no errors or

warnings on any step. However, if you do receive errors, go back to the previous sec-

tions and check the project assembly steps. Errors will prevent the project from build-

ing. If you receive warnings, you may ignore them for this project as they will not

prevent the project from building. To turn off the display of warnings, do the following:

+ Select Project>Build Options>Project and click on the MPASM Assembler tab.

+ Select “Output’ from the “Categories” drop-down list.

+ Select “Errors only” from the *Diagnostic level” drop-down list.

+ Click OK.




[image: image66.png]OUTPUT WINDOW

508 | Verion G i |

[Evecuing “CtPragrem FiesiMiciochipMPASM SuteWPASMWIN exe*, 2]
[Executing "CiProgrom FilesiMisrachpMPASM Suteimplink 2xe fo16FE
METINK 430, Linker

Copseisii (&) 2005 Microchip Techolosy Tne

[Eveare

MP2HEX 430, COFF to HEX File Converter

Copessie ' (¢) 2000 Hacroctip Technolosy Tre

[Erears

lLoaded C\ProjectsiyProjectiyProjectcol

[Rease buid of project C:ProjectsIMyProjecthyProjectmep succeedt
[Tue Aug 12 100321 2008

IBUILD SUCCEEDED

|





[image: image67.png]CREATING CODE




[image: image68.png]Open the template file in the project by double clicking on its name in the Project
Window, or by selecting it with the cursor and using the right mouse button to bring ug
the context menu:
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[image: image70.png]Select the simulator as the debug execution tool. This is done from the
Debugger>Select Tool pull down menu. After selecting MPLAB SIM, the following
changes should be seen (see corresponding numbers in Figure 4-16).
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2

®

©

®

)

The status bar on the bottom of the MPLAB IDE window should change to “MPLAB
SIM"

Under the View menu (not expanded), additional simulator windows.

Additional toolbar icons should appear in the Debug Tool Bar.

TIP: Position the mouse cursor over a toolbar button to see a brief description of the
button's function.

|

Additional menu items should now appear in the Debugger menu

AnMPLAB SIM tab is added to the Output window.




[image: image71.png]MPLAB® IDE DESKTOP WITH MPLAB SIM AS DEBUGGER
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Now that your project is set up and the debug tool is selected, you should save your
vorkspace setup. Select File>Save Workspace




[image: image73.png]TABLE 4-1: DEBUG SHORT CUT ICONS

Debugger Menu Toolbar Buttons Hot Key
Run > Fo
Halt 5
Animate 13

Step Into o F7
Step Over . 8
Step Out [

Reset B 6




[image: image74.png]Next, press the Step Into icon or select Debugger>Step Into to single step to the code
at Main.
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Conclusion:

The project “CAN BASED CAR AUTOMATION SYSTEM” hasbeen successfully designed and tested.
 It has been developed by integrating features of all the hardware components used. Presence of every module has been reasoned out and placed carefully thus contributing to the best working of the unit. 

Secondly, using highly advanced IC’s and with the help of growing technology the project has been successfully implemented.

 Future Aspects:

We can extent this project to vehicle supervisory cum fault announcing for light vehicle(using sensors).
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